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Integrated Modelling

In this guide we introduce integrated modelling. You will load three projects containing a
combination of 1D and 2D modelling components and simulations. For each, you will build
the linked components needed to combine the relevant aspects and learn which data is
required within the simulation itself to define the links. Finally, you will setup and run three
fully integrated simulations and view the results from these.

Introduction

In the previous 'Getting Started’ guides, we investigated 1D modelling and looked in detail at
a river network and an urban network. We also considered 2D modelling, and created a
model representing a floodplain in 2D.

Integrated modelling incorporates 1D river, 1D urban, and/or 2D modelling components
with additional linking elements to enable them to exchange information dynamically as a
simulation runs. This enables the user to take advantage of the best aspects of each
modelling type.

In this guide, we will look at building these additional linked elements, and adding them to
the simulations. This will be split into three parts: integrating river networks and 2D
components, integrating river and urban networks, and integrating urban networks and 2D
components.

We assume (and highly recommend!) readers of this guide have previously completed
‘Getting Started — Essentials’, ‘Getting Started — River Modelling’, ‘Getting Started — Urban
Modelling’ and ‘Getting Started — 2D Modelling’ which can be accessed here.

Please note that there are a variety of ways to undertake different tasks in Flood Modeller.
Throughout this guide, we provide details of selected methods only.

We will use data contained in the IntegratedModelling folder for this tutorial, which can be
found within the GettingStartedData folder. Access this here if needed.

Tip: We recommend reading the entirety of each instruction, including the labels on the
image provided, before carrying out each step.
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Part One: River and 2D

You can integrate river networks and 2D components to allow (for example) water
overtopping a riverbank to flow onto the floodplain. To integrate a river network and 2D
components, you must first create the ‘link-lines’ to indicate which nodes are connected, and
how the flow is transferred at each. The 'River 1D / 2D Link Line Generator' tool can be

used to draw these link-lines directly onto the map view. After defining the link-lines, an
integrated 2D simulation can be set up. This needs to specify your link-lines file and 1D river
simulation, alongside your 2D components.

In the first part of this guide, we will integrate a river network and 2D modelling components.
We will run a fully integrated simulation, allowing us to capture not only water overtopping
the river and entering the floodplain, but also flowing back into the river as the topography
allows.

Let's get going!

Step 1
Open the project Riverand2D.fmpx (in the IntegratedModelling>Riverand2D folder)

Various 1D river and 2D components will load into the interface — these should all be familiar
and the guides 'Getting Started: River Modelling’ and ‘Getting Started: 2D Modelling’ should
be referred to for further details as needed.
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Tip: In the ‘Layers’ panel, right-click DEM_2m.asc and hover over ‘Colour Ramps’ to select a
terrain option from the default list provided. Recall from ‘Getting Started — 2D Modelling’ an
option such as ‘Terrain_Hillshading' is most appropriate.

N F M r www.floodmodeller.com
Bt by!.J?c?tS odelle ©2021 Jacobs | All rights reserved


www.floodmodeller.com

‘Getting Started’ guide | Integrated Modelling

Step 2
Open the 1D simulation called ‘RiverOnly’. The blue arrow to the left of the simulation name
indicates the results are already available for this simulation.

Take note of the timestep used for this 1D simulation. This will be important when setting up
the integrated simulation. Also notice the end time has been provided as 30 hours; we will set
our integrated simulation to run over the same period. Close the 1D simulation after you
have viewed the parameters used.

Highlight the 1D RiverOnly PR
Map Tools Simulation Results Catalog n .
. . . . Pl
S|r’[1ulat|on, ”?cht d';k and wemme | N€ simulation window opens. In the Times tab, we
select Open from the menu W can confirm the timestep used was 2.5 seconds A
7‘_; l::fjmm " + . ;E'; P — 1 IR [| 1 1D Scenario Daty/ RiverOnly ES
- M::;: r Set Active File Ryp Help
\lb Inital Condt Simulation Builder Files
]
= Run Type
::"“"r‘ ..... O steady Direct) @ Unsteady (Fixed Tmestep) '\ O Boundary Mode
ow File Location = -
Properties
. ) . (Adaptive timestep)
Moy The Finish Time is
, N Lines indicate a set to 30 (hours)
1 D Simulation Timestep [s] Save Interval (5]
E] [>  sipdsfions e e s e ]
H; = » RiverOnly
B - Riverand2D :
e 2
' Cross hatching indicates - . )
. : Close the simulation when you
a 2D simulation )
have viewed the parameters.
X: 385814.106 Y: 237880.951 rad
[ ] www.floodmodeller.com
o Flood Modeller

by Jacobs ©2021 Jacobs | All rights reserved


www.floodmodeller.com

‘Getting Started’ guide | Integrated Modelling

Step 3

The first part of integrating river networks and 2D components is to create a link-line. This

will determine where and how water can transfer to and from the river.

Use the 'River 1D/2D Link Line Generator' to create a link-line from Upton_09065 to
Upton_05310. Trace along the active area shapefile to define the path for your link-line.

For this tutorial, we will consider the default link type of ‘Level Link'. This is typically used for
flood flows discharging laterally into the floodplain over natural or non-walled banks (i.e.
those without a linear defence). The water level in the river is calculated and passed to the
2D, and the discharge is extracted from/applied to the river network as a lateral

outflow/inflow.

Please see the user manual for further details on ‘Weir Link’ types (typically used for flood
flows discharging laterally into the flood area over a linear defence) and ‘Flow Link' types
(appropriate for a river discharging into a 2D area downstream, e.g. river modelled in 1D;

estuary modelled in 2D).

Choose a filename and save location and click ‘OK’ to finish your link-line.
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Select Trace along shapefile’ and
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Other values can be left at their

Click to choose a name
and save location.

Finally, click OK'. Keep the &
window open if you like!

Note: If we were choosing the path based on the active river network, we would need to select
‘Right Bank' as left/right is determined as if looking at the river downstream.
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Step 4
Your link-line will now show in the map view. The shapefile is also added to ‘Layers’ panel.
Adjust the visual style of the shapefile as needed to make the line more visible on the map.

Your link-line is now ready to use! Don't forget to save the project to add this shapefile to the
other project files.
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Step 5
The second part of integrating river networks and 2D components is to add the 1D
components and the link-line to a 2D simulation.

Open the 2D simulation ‘Riverand2D’ (or you could start a new 2D simulation here!).

You will notice the topography and an active area have been defined, and the run timing
details are also already provided. This should all be familiar from ‘Getting Started: 2D
Modelling'.

Note that the timestep (in seconds) is half of the grid size (in meters); we recall from ‘Getting
Started: 2D Modelling’ that this is the recommended setup.

Also note the timestep is twice that of the 1D only simulation (from step 2 above). For
integrated modelling, it is required that timesteps are multiples of each other, and
recommended that a 2D timestep used is double any 1D timesteps used.
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Step 6

Add the 1D components to the 2D simulation by navigating to the ‘General’ tab and simply

checking the box provided to ‘Include link to a 1D River model'.

You will notice a .csv filename automatically populates the field immediately to the right -
this file will be created at runtime and contain a summary of the flows across the linked

aspects (the link-line, in this case).

A new tab will also automatically appear entitled ‘1D River Links'. In this new tab, fields are
provided for the 1D river simulation file ‘RiverOnly.ief’ and your link line shapefile. These can
be dragged over from the ‘Project’ and ‘Layers’ panels or browsed to via icons provided.
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Tip: Don't forget to save your simulation to keep your changes.
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Step 7

Your integrated river-2D simulation is ready to run! If you find your simulation is very slow,
you may find it helpful to increase the grid size, although recall from ‘Getting Started — 2D
Modelling’ that this reduces the resolution of the results.

View the results from the simulation. Animate the water depth and investigate how much of
your active area floods.

Is your active area big enough? Turn on the ‘flow’ output — are there any areas where the flow
appears to reflect from the boundary of the defined active area? Increase your active area,
ensuring it remains clear of grid cells with “no data” defined. Save and re-run the simulation —
can you create an active area to contain all the water throughout the simulation time?

In the ‘Project panel, right click on the simulation and select O __
Avalable Layers: Avallable Timesteps:

‘View Result'. Click 'OK’ from the pop up window to load this. SEEREEREC v ———— 3 P
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Houtput-Domain 1_velocity.dat Unload DATMOF
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The results load in the Right click and select ‘Animate .
‘Layers panel. Check the
boxes to view the outputs.

- Animation functions appear in the top left of the map view.

Tip: Remember to close the animation toolbar when you have finished viewing the animated
sequence (leaving this open can cause unexpected things to happen when you continue
working!)
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Part Two: River and Urban

Integration of river and urban networks allows (for example) the outflow from a pipe to enter
ariver. To integrate a river network and urban network, you must initially set up the ‘link-
references’ to indicate which nodes are connected, and how the flow is transferred at

each. The "1D Urban / 1D River Linking Definition' tool is provided to assist with this. After
defining the link-references, an integrated 1D simulation can be set up. This needs to specify
your link-reference file, alongside your river network and urban network.

In the second part of this guide, we will integrate a river network and an urban network. We
will run a fully integrated simulation, allowing us to capture not only the outflow from the
pipe entering the river, but also any water entering back into the urban system if the water
level in the river exceeds the outflow height.

Let's get going!

Step 1
Open the project RiverandUrban.fmpx (in the IntegratedModelling>RiverandUrban folder)

A 1D river network and 1D urban network will load into the interface — both of these should
be familiar and the guides 'Getting Started: River Modelling’ and 'Getting Started: Urban
Modelling’ should be referred to for further details as needed.

Recall you can open a project ¥ DRl & Dubor

Labels W 1D Urban irks

from the icon in the ‘Home' tab  #& 2 overe

W 1D Urban i

Open Street Map
« Bing Maps 1D River Network (River_Netw... 2 x

Bing Satellite it Label 1
= General (S1)

The river network and
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into the Project’ panel.
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i RIVER Upton_18142
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¥ Spatal Data

; e T
i Bl T
; [¥] RIVER Upton_16584
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Upton_15646

_TWO simulati.ons load | f A - The river network also loads
into the Project’ panel. AN 2% I\ S into the map view and the
] ‘ 1D River Networks panel.

The urban network
loads into the map view.

son 3’

Recall we can also view the nodes and links in the
1D Urban Networks panel by clicking on this icon.

Upton_13090 200000 9289 o

X: 384199.774 Y: 240904.94 2

Note: On loading the project, the software will automatically set the selection mode to ‘1D
River'. Recall that this can be adjusted via the right-click menu on the map.
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Step 2

Let's look at the details for the 1D simulation associated to the urban network. Recall from

‘Getting Started — Urban Modelling' that the settings for this are all contained within the
urban network itself.

Note that the dynamic wave routing model has been selected, and that variable timesteps are
turned off; this must always be the case to integrate your urban network with other
components (both river and 2D).

Take note of the timestep used for the 1D simulation. This will be important when setting up
the integrated simulation. Also notice the start and end times have been provided as
absolute dates; we will set our integrated simulation to run over the same period. Close the
model settings after you have viewed the parameters used.
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Step 3

The first part of integrating river and urban networks is to create a link-reference. This will
indicate which nodes are connected, and how the flow is transferred at each node. This
information will be saved in a file with extension .isl.

For this tutorial, we are interested in connecting the outfall node ‘Out1’ of our urban network
to the river network.

Use the ‘1D Urban / 1D River’ linking definition tool to create this link-reference.

For this tutorial, we will consider the default link type of ‘Flow to river, stage to urban’. This is
typically used for flows discharging from a pipe network into a river. The urban network
discharge is applied to/extracted from the river network as a lateral inflow/outflow, and the
water level in the river is calculated and passed to the connected urban node(s).

In this instance of connecting an ‘Outfall’ node, no additional modelling parameters need be
defined for the water level to be passed back to the urban network dynamically during
simulation runtime. Please see the user manual for further details on connecting ‘Junction’ or
‘Flow Divider' nodes, and on the ‘Stage to river, flow to urban’ link type (appropriate for a
river discharging into an urban network downstream).

B e S % Dusmiars G [ .
= | Overlaps. asg 1D Urban - 1D River linking definitigadas
Load Urban 8 Save as

rban k Node properties  Link tie
fratien O 10 rbannodes ¥ 1D Urban inks P proper

1D Urban Edit

WRiverandUrban & & x
EE 1D River Networks
Select 1D Urban Mode! (browse or drag from Project Panel):

C \Usefs\Desktcp\Tulmds\Guides\RiveraﬂdUrban\slmuldlons\U!ba"_NE‘WZ!UrbaH_Ne‘WkaJ'v s -
—

Initially scroll to the bottom of the

PR 5ble and click on the Outfall node hdec  DUbaNode oi DA% comecton Type Conmer.
S [>  Smuations JTE JUNCT\ON | -

=M Then click Start Linking ... 19T G il >
OUTFALL
B
View advanced parameters
- 50 the button turns red - To define 1D Urban to 1D River inks cick the Start Linking button ‘ =
Layers o . Highlight 1D Urban node in table, then click on a 1D River node on map to create new link
s - (vhen all links defined. click the Stop Linking button
O3 |55 v < ”
View defined linking Open Save Close la
Point
Now on the map, click near
the node Upton 08760’
to connect to this node.
125m

s Finally, click Stop Linking .

X: 384949.922 ¥: 240646.467 z Selection mode: 1D River

Note: The flow from ‘Out1’ is applied to the river network as a lateral inflow between
‘Upton_08760' and the next downstream node; ‘Upton_08560'.
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Step 4

Choose a filename and save location for your link-reference. Confirm visually the link

connects the expected nodes. Now you can close the ‘1D Urban / 1D River’ linking definition
tool.

Your link-reference is now ready to use!

- — ==

9 Save As O o o ofere e has bee ade o o ode na o added to ero
« - A « RiverandUrban > spatial_data
Organise =  New folder e @ 9 JUNCTION ] | |
A Name - Date modified Type J10 JUNCTION h
# Quick access It JUNCTION =
Deskt No items match your search.
e A n JUNCTION -
& Downloads »*
bl J13 JUNCTION =
5| Documents . 1
=] Pictures " 315 JUNCTION -
Practicals Data # 16 JUNCTION A -
e > O o =
File @@me | TGEETEE ~ 5
Saveas i >
dvVe and selc = = € and || View advanced parameters
~ Hide Folders -
ofare o o on
0Catio O O 1D River node e new link
. on
16 7D Utban nodets)
Layers oax —
- Ba2n e
OM|5= TL w

Upton_15646
Upton_15157

w8 . O
/ : 3 Homry: [/
125m /] Trtreeegm 0 SE ST R N oo
[T f ¥ { /
*

X: 385428.959 Y: 241188.687

Tip: Save your link-reference file (extension .isl) somewhere in the RiverandUrban folder (and
remember where — you will need this later!)
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Step 5
The second part of integrating river and urban networks is to add the 1D urban components
and the link-reference to a 1D simulation.

Open the 1D simulation ‘RiverandUrban’ (or you could start a new 1D simulation here!)

You will notice our river network (and initial conditions — these are now contained within the
river network) have been specified, this should all be familiar from ‘Getting Started: River
Modelling'.

Note that the timestep is the same as used in the simulation associated to the urban network
(from step 2 above). For integrated modelling, it is required that timesteps are multiples of
each other, and recommended that 1D timesteps used are identical.

Note also that the start and end time match the time within the simulation associated to the
urban network (from step 2 above). Absolute times must be provided when linking to urban
networks.

In the Simulations section of | /811D Scenario Data - RiverandUrban E3
0 . . . File Run View Help T y
the ‘Project panel, Highlight In the ‘Times tab, the Unsteady (fixed
the simulation RiverandUrban timestep)’ run type has been selected.
Run Type
Right click and select ‘Open .
() steady (Direct) (®) Unsteady (Fixed Timestep)) () Boundary Mode
b
(} Spatial Data
Ch- ] i 1D Urban Networks (O Steady (Timestepping) (O unsteady (Adaptive timestep)
£ '”’:;"G—;:"‘" Set Active
> ::::ums Simulation Builder
B = .
5 Timestep [s] Save Interval (3]
Remove Use Time Zero
Show File Location Start Time Date
Poopeities | -> Relative 00:00:00 5 | [20 February 2000 V‘ )
Loy o x _— s The timestep of 2.5 seconds
o iy [3an] | Finish Time Date o . )
LM% 34 > Retative f 06:00:00 2] [zt February 2000 v] is identical to the timestep
' used in the urban simulation.

% The start and finish dates/times = e
match those of the urban simulation.

125m J
400 1t T
7
.N Copyright & 2014 Microsofe and its swplisrs

X: 385032.633 ¥: 240822.229 Z Selection mode: 1D River 8 | - E 0

< >

Note: Recall the river network details are provided on the ‘Files' tab.
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Step 6

Add the urban components to the simulation by navigating to the ‘Links’ tab. You may need
to click ‘'View’, then hover over ‘Tabs' and select ‘Links’ to see this tab.

Fields are provided for both the urban network file and link-reference file. Simply use the
button to the right of the field to browse to the location of your urban network and add this
to the simulation. Similarly, browse to the location of your link-reference file to add this.

TE - &8 X
You may need to click View, then hover over Tabs' and select ‘Links to see this tab n-
LoadUrban B spveas | 1D 1D Urly W] 1DUrbaninks  Node propertes  Link properties 1D Urban Ful 1D Urban Options
Networ
1 1D Scenario Dgfa - RiverandUrban E3 Tabs > Parameters 3
@Rvd  File Run @ Help Advanced Parameters Niise
R o o (& tins i
- Fles T Diagnostics
".‘ TUFLOW Link options Snapshots
EE 2-d scheme CES
B None ~ Low Flow Options
% [Aa0s ] Output Veriables
B 0 Backwards Compatibility
= e e Double Pre ) Updating
S Browse to the location of Gontrol module
your urban network file - R
= Rver
1D River -1D Urban Link options . Lnnen 5 ¥
Layers 1D Urban Control File e =
Oos ‘\s‘rmlabons”bm,NemorkUrban,Nemrkino Tael y flow stage A
= = Del
i e Browse to the location of s W mee. oo
E [iIRNerandUrban\spaual_dam‘&.inldieferences‘isl ( - D P . ) E:::i:jz : EE ::;
-’ vour link reference file e 0y MGom [5ak
Upton_17128 ¥y 200000 9772
Upton_16584 y 200.000 9.699
Upton_18082 y 200.000 9.651
Upton_15646 y 200000 9593
Run Upton_15157 y

Tip: Your urban network file is in the folder ‘simulations’ > ‘Urban_Network’ (in the
RiverandUrban folder). Your link-reference file (extension .isl) is wherever you saved it in step

4 abovel
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Step 7

Your integrated 1D river-urban simulation is ready to run!

Look at some of the results from your simulation. Animate a ‘Long Section’ plot to see the
water levels changing along the entire river network.

The simulation has considered the ‘Flow Time' boundary at the upstream end of the river (as
we saw in the guide ‘Getting Started: River Modelling’). The additional water discharging from
the urban network ‘Outfall’ node (as we saw in the guide ‘Getting Started: Urban Modelling’)
has also been added during simulation runtime.

There is a slight increase in the levels and flows in the river due to the discharge from the
pipe, however this is negligible compared to the water already contained in the river.

FETUNS B0 CONCTatIoN TIEs 1O PIOt [UNTICK OF EMOVE 311 10 PIOT DEQ proTe)

Selected Items:
Upton_18005

Available Items:

IzDgEZR0 -

@RiverandUrban = = x

Home 1D River Buid 1D Lrban Buid 20 Buid Hydrology Map Tools \lan)?ﬂ
| | Tme series. =
- g |# x v Seies 2] . .
el A L Click to add your results file

1D Results

Cross 1D Haad

On the Results tab, click Long Section .

> inital Conditons
®  spansData
= 1D Urban Networks

& / s

oo
Upton_12652
Upton_14257

Upton_11092
Upton_10583
Upton_10146
Upton 09611

Variable

Flow

Variable(s) Units

(m3/s)

. 0 5 .
R s Click ‘Yes' to include all nodes. Upton- 13050 @ o
¥ Upton_12590
Wver_bichwork ums:_‘zwz Variables Plot Time Range
M EventData Upton_11622 Start Time [20/02/2000

-

20/02/2000
End Time [21/02/2000 off

B Urban Network Upton_03085 stage v map) (2110212000 0s:00:00
") Associated Data bt Froude Number Selected Time:
% on_ [ —
> Simations Upton_08082 Velocity Py 20/02/2000
Ha Upton_07538 e
Upton 06591 it Mode
Upton_08471 Unit State
frersmgreld Water Depth (m
Lo Sectbo Upon_19005 - Uon 00500 - Marimum Stage im AD)
Animation ] Minimum Stage (mAD)
"\ Total Energy (m AD)
controls Edit Chart Upton_04026 Initial Stage {m AD)
= T i Seres.. Upton 0342 v | Maximum Fiow im3/9)

4 20f17 b W

Print.
Print Setup...
Print Preview...

The stage for the entire network is displayed.

Copy To Clipboard
Export
Legend On
¥ Highlight Points
Show Chainage

Right click on the plot to select ‘Animation . a2
Animation controls are then displayed in the
top left corner of the plot.

Note: The results file by default will be located in ‘simulations’ > ‘RiverandUrban’ > ‘Output’
(in the RiverandUrban folder).
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Part Three: Urban and 2D

You can integrate urban networks and 2D components to allow (for example) overflowing
manholes and drains to discharge onto overland urban areas and floodplain. To integrate an
urban network and 2D components, you must first create the ‘link-elements’ to indicate
which nodes are connected, and how the flow is transferred at each. The '1D Urban / 2D
Linking' tool is provided to create these link-elements in polygon, line, or point format. After
defining the link-elements, an integrated 2D simulation can be set up. This needs to specify
your link-element file and 1D urban simulation, alongside your 2D components.

In the final part of this guide, we will integrate an urban network and 2D modelling
components. We will run a fully integrated simulation, allowing us to capture flow exchange
dynamically at runtime of not only the outflow from the pipe junctions entering the
floodplain, but also any water entering back into the urban system.

Let's get going!

Step 1
Open the project Urbanand2D.fmpx (in the IntegratedModelling>Urbanand2D folder)

Various 1D urban and 2D components will load into the interface — these should all be
familiar and the guides ‘Getting Started: Urban Modelling' and ‘Getting Started: 2D
Modelling’ should be referred to for further details as needed.

Flood Modeler - Urbanand 2D fimpsc™ T E - 8 X
Recall you can open a project o PO D ks ) DR © 1 verCptens

| Channel icons Labels ! 1D Urban inks (&) General

from the icon in the 'Home' tab 1\ AR s

Uinks /] 1D Urban not P2 kst

(

Open Street Map

= avout -

« Bing Maps 1D Urban Network (Urban_Netw... #

Add a basemap and Bing Satelite !
labels/icons to your e

®@urbanand2D o & x :
& 1DRiver Networks

[ e The urban network loads \
Spatial Data

E n into the Project’ panel.

Name Type
SUBCATCH
SUBCATCH
s SUBCATCH

s10 ‘SUBCATCH

None =

s11 SUBCATCH

Two simulations load
into the Project’ panel.
The urban network also loads
into the map view and the ‘1D
B Urban Networks panel.

Recall you access this
from the 3’“' icon here

u
AN

The 2D components (an active area
and DEM) have loaded into the : !
map view and the Layers Panel e R,

Tip: In the ‘Layers’ panel, right-click DEM_2m.asc and hover over ‘Colour Ramps’ to select a
terrain option from the default list provided. Recall from ‘Getting Started — 2D Modelling’ an
option such as ‘Terrain_Hillshading' is most appropriate.
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Step 2
Let's look at the details for the 1D simulation associated to the urban network. Recall from

‘Getting Started — Urban Modelling' that the settings for this are all contained within the
urban network itself.

Note that the dynamic wave routing model has been selected, and that variable timesteps are
turned off; this must always be the case to integrate your urban network with other
components (both River and 2D).

Take note of the timestep used for the 1D simulation. This will be important when setting up
the integrated simulation. Also notice the start and end times have been provided as
absolute dates; we will set our integrated simulation to run over the same period.

o Flood Modeller - Urbanand2D. fmpx* = 2 8 X
Inthe 1D Urban Networks section of the | _—. Meide| setings - R Nebrorifi *| g
‘Project’ panel, select the urban network.  Esdlivisinaiindutuin B DvnamkwM Files
nt i Non channelicons /| Overlaps Diyi HrMin:Sec
Right click and select ‘Model settings . ; = Reporting Step| [0 [5] Potso0 |5 . ;
v On the ‘Time Steps tab, the
Initial Condibons . . elected
Scoti Data | routing step is set to 2.5 seconds A
P m‘ . 3 < Control Rule Step
g v lodel sciting) On the General tab,
B U Climatolo . ). Routing Step (seconds) @l
£ Dynamic Wave' is selected )
Model defaults Steady Flow Periods
View » D6 - [[] Skip| Model settings - Urban_Network.inp
Zoom to Network Model settings - Urban_Networkinp Geﬂul Time Steps  Dynamic Wave Files
ELIA\SS s Remove EFlow Roung General Dates Time Step< Dynamic Wi Date (M/D/Y) Time (H:M)
s N D e S Nyison 2202000 T3] om0 T3]
[ o > Show File Location 0 ' .
| e i n the ‘Dynamic Wave I
= Properties g 3 ‘ v c g Start R§porting on @ 00:00 |5
O teady flow tab, the ‘Use variable time -
O Kinem¥hic Wave steps box is NOT checked g v i :
T
(LB Also take note of the analysis
e —— o : start and end times/dates
[ ] www.floodmodeller.com
o Flood Modeller
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Step 3

We are interested in connecting urban junction nodes (rather than just outfall nodes) and
desire a two-way exchange of flow (i.e. for flow volumes to also be returned to the urban
system). It is therefore necessary to “Allow Ponding” and to ensure a ponded area is set for
each of the junction nodes. In the case that the “Allow Ponding” option is not selected or the
ponded area set to 0, water can discharge from the urban network to the 2D components,
however no volume is returned to the urban network.

Note that “Allow Ponding” has already been selected for the simulation associated to our

urban network.

Check the ponding area provided in the junction nodes themselves. A ponded area has been
defined for every junction except for junction J11. Adjust the ponded area in J11 to 100 m2.
Remember to type your new value, then press enter to confirm the adjustment prior to

closing the junction property window.

The ponded area set for a node connected to a 2D domain should be comparable to the area
of the connection. The area for the default (polygon) connection is 9m?, and the ponded area
will be the area of the grid cells required to cover this. For this tutorial, we shall see the grid
size is set to 10m, and thus the ponded areas are set to 100m?, 200m? and 400m?
(depending on whether the default polygon connection lies within 1, 2 or a set of 4 adjacent
grid cells). Note that any changes to your active area may adjust the underlying grid cell
placement, and thus the ponded area. It may be helpful in practice to run a model for a single
timestep and adjust the ponded area based on the diagnostic messages provided.

Flaod Modeler - UrbanandZD. fimp

HM“““ Setings - ibancieterncng i3 i In junction J11, click on the Ponded Area field.
@ ates  Time Steps Dynamic Wave Files @ zoomin < Zoomundo | ¥ 1D Rvertodes Type 100’ and press enter to adjust the value.

€, Zoomout [ Zoomredo | [ Channel icons v
Proce¥ Models Infiltration Model Gppan @ rulextent | | Non chamnelicons /i Overlap ! 1D Urban icons
Map vew

A Rainfdy/Runcff (O Horton

X-Coordinate 385294.287
240156.216

Y-Coordinate

On the General tab’ of the
Model Settings window,
‘Allow Ponding' is checked.

385123.238
240361.015

-Coordinate Description

Y-Coordinate

Tag

NO

Description Inflows

Treatment

Most junctions already have -

13.5

Routing Model Routing Options N
a ponded area defined Max.Desth 4
O steady Flow 4 Allow Ponding o [S13 Initial Depth 0
O Kinematic Wave Minimum Conduit Slope s aiincis o ’ Surcharge Depth
Initia! Depth ;
Ponded A

Area of ponded wat
(m2)

B

Click OK to close this
window and proceed to
confirm a ponded area is
set in each junction node.

Recall you can open node/link properties
from the map or the Urban Network table.

Note: Don't forget to save your urban network after making this adjustment.
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Step 4

The first part of integrating urban networks and 2D components is to create the link-
elements. This will determine where and how water can transfer to and from the urban
network.

Use the ‘1D Urban/2D' linking tool to create the link-elements from all junction nodes to the
2D active area. This information will be saved in a file with extension .shp.

For this tutorial, we will consider the default link type of ‘Q (flow) Link'. This is typically used
for flood flows discharging onto the floodplain. The discharge is applied to/extracted from
the 2D domain, and the resultant ponded volume is calculated and passed back to the urban
system. Please see the user manual for further details.

Choose a filename and save location and click ‘OK’ to finish your link-element file. This is now
ready to use! Don't forget to save the project to add this shapefile to the other project files.

SFEHZE0 - SRS !
% “;f =Y - ¥ Onthe 1D Urban Build tab, M The tool opens within the A:
% G piill click 1D Urban /2D’ linking [## 1D Urban Network panel

Load Urban Save as
bl - b

1D Urban
Wubanand2p o » x |

58 1D River Networks
EventData
{» inival conditons

b Speteineta 2 The table now only shows a
S B 1D Urban Networks E . . . o i
o8 E—— ~ . = nodes valid for linking. B - o
i g - 2 R Click in the table to select E il
LE - Urbanand2D " . . v Q
all the junction nodes. B - ¢
H v e
(@] Y Q
2D Urtian Inking Then right click on the table and select = 2
2D Lnking shapefie. | Advanced Create 2D linking for selected nodes . = St
o] 4 e
O Append to existing 2D linking shapefie = v g

@ Create new 2D inking shapefile L View [ S bianaia
om S ——

Top tip: Hold the ‘Ctrl’ key to select multiple rows in the table. Use ‘Ctrl + A’ on your keyboard
to select all nodes. [In this instance, to select all ‘Junction’ nodes, you could select all nodes
then hold 'Ctrl’ and select the ‘Outfall’ node (to deselect that node).]
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Step 5
The second part of integrating urban networks and 2D components is to add the 1D
components and the link-element to a 2D simulation.

Open the 2D simulation ‘Urbanand2D’ (or you could start a new 2D simulation here!)

You will notice the topography and an active area have been defined, and the run timing
details are also already provided. This should all be familiar from ‘Getting Started: 2D
Modelling'. Note that the start and end time match the time within the simulation associated
to the urban network, as seen in step 2 above. Absolute times must be provided when linking
to urban networks.

Note that the timestep (in seconds) is half of the grid size (in meters); we recall from ‘Getting
Started: 2D Modelling’ that this is the recommended setup.

Also note the timestep is twice that of the 1D only simulation (from step 2 above). For
integrated modelling, it is required that timesteps are multiples of each other, and
recommended that a 2D timestep used is double any 1D timesteps used.

SeEZE0 - Flood Madeller - Urbanand2D.fmpx T E - 8 %
I_Sn Active IDikbanBuld  Buld  Hydology MapTools  Simuation  Resuts  Catdlogue n-
Simulation Builder — . . = On the Doma'ns tab the = &N
oy Right click Urbanand2D — ' '
View Result = and select Open to s topography and active d
Eosd Gis Duts area have been added v

open the 2D simulation

Remove

Domain Detals

Boundary Conditons | Ramfalll
Topography (Note: Lower layers in list ove

Show File Location

Properties

2D Simulation (Unit System:

| LogFie:

On the General tab, the
. start and end time match
n[=z[EE that of our 1D simulation

Roughness grid MasterMag e
[+) Fiename

e The timestep is set to 5 seconds.
i} The 2D timestep should be double

that of the 1D urban simulation.

EE0k0 S ke ke Sippiare] | oo | e
xo| | - Genersi pons . i - i @
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Step 6
Add the 1D components to the 2D simulation by navigating to the ‘General’ tab and simply
checking the box provided to ‘Include link to a 1D Urban model'.

You will notice a .csv filename automatically populates the field immediately to the right -
this file will be created at runtime and contain a summary of the flows across the linked
aspects (the link-elements, in this case).

A new tab will also automatically appear entitled ‘1D Urban Links'. In this new tab, fields are
provided for the 1D simulation associated to the urban network and your link-element
shapefile. These can be dragged over from the ‘Project’ and ‘Layers’ panels respectively (or
browsed to via icons provided).

2o - Fiood Modeler - UrbanandZD. rpx* T @ - 8 %

IDRverBuld 1D Lkb]

: g
i S:‘; General Dmui
=d £ s 2D Model Info.
Project DRt | | | ame: Check the box Include link to 1D Urban model A
Wurbanand2D © & x E Desaiption: | and anew tab automatically appears ymlDUrbanNemork-lenlung.” & x

2D Simulation (Unit System: SI)

Neme |Type | Symbol |Selected |Link Type
| [n anct

Inital — = =
¥ Spatial Data ,
S @ 1D Urban Networks & Q& Include ink to 1D Urban model Output Frequency (s): K - n T

B uman_ Network | Bl 1B et
Associts Run Timing Ao~
imuiaty Timing options ‘ 3 JMCT.

M » Urban_ WQork ® Normal > )

Bl Urbanandd = s 2D Simulation (Unit System: ST) - o IEE

General | Domains 1D Urban Links

e — Urban Model
Urban Network I Urban Model File (%inp): _  [Orban_etworkinp
View inp fie

1D - 2D Link Shapefiies:
Shapefile
» |C:\Users\Urbanand2D\spatial_data\LinkedElements. shp

Koo LoOOOPbLhOOOARORO

General options
i# FFIDEM_2m.asc .
LinkedElements.shp On the 1D Urban Links tab, the ...oryou ca.n
urban network and link elements browse to files

220 T can be dragged in from the using the icons
750 .

st e i Project and Layers panels... provided.

X: 384160.627 Y: 240756.28 Weir Discharge Coefficent: -

Note: The advanced parameters can be left at their default settings.
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Step 7

Your integrated urban-2D simulation is ready to run!

View the results from the simulation as you would with other 2D results. Animate the water
depth and investigate how much of your active area floods.

For integrated urban-2D simulations, the linked flow summary can also be plotted — this is
the .csv file mentioned in step 6 above. Select a ‘Junction’ node and view a ‘Time Series’ plot
of the linked flow. Note that at some of the junction nodes, little or no flow enters the 2D
domain.

Flood Modeller - Urbanand 2D - « » ions > w ® | Search Urbanand2D

Select a node and click Time Series [Nl
to view the linked flow summary rhas

tial_conditions

~

Urbanand2D_02 File fof

22/12/2020 08:13 Micro:

networks 6] Urbanand2D_1DLinkFlowsSummary
al 1 2/2020 08:13 Micro
9 0 9 g [T Urban_Networ
In the project panel, right click on 1 iCinrai
| v €
the simulation to View Result . 1 pame:[UrbomandZD_IoLinkFiowssammary 1ok nfows -cs)
. e S =
Load GIS Data ::‘::"’
Open M I e = 20/02/204
Remave m3js %
Show File Location
Layers 2 Properties . B 1D Urhian Time Series: 0-29.750h,
O8|=3 T | s 4
= = Delaul Grouwp Yeujeign 15 | - \
DuEm-ﬂDJ]\uulumO. .\‘: \ / \
= . . / . .
2 Dl e Layer . v\ The linked flow is added as
8 [ output-Comain 1_atef Animate o a
° S 5 N —" " s \ a new variable for plotting

g
4 £2s
N E‘"S 52’:;:.:» / Show Colour Remp § 5 \\ @
. . - 15 K el O |mys
Right click the result s / \ Fii'E I

and select Animate’ 2 “”J \\é/ -
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Summary
You now have had an initial introduction to integrated simulations.

Part One — River and 2D

In part one of this guide, we saw that a valid river network (and a stable 1D simulation using
this) is required for integrating river networks, and that the 1D timestep is important to take
into account for our linked simulation.

We saw that an underlying DEM is required when integrating 2D components and recalled
how an active area can also be provided for 2D modelling, and how these can both be
adjusted and manipulated in the ‘Layers’ panel of the interface. We saw that a link-line must
be defined to connect the river network and the active area.

We used Flood Modeller’s built-in ‘Link Line Generator’ tool to create a shapefile for this line
by simply choosing some options from drop-down boxes. This automatically created a link-
line ready for use in our simulation.

Finally, we set up and ran our fully integrated simulation, animating the results from this to
see the water flow from the river across the active area. We used a 2D timestep of 5 seconds,
following the guidance that the timestep (in seconds) is half the cell size (in metres) as well
as double the value of the 1D timestep (in seconds).

We considered the default link type of ‘Level Link’ typically used for flood flows discharging
laterally into the floodplain over natural or non-walled banks (i.e. those without a linear
defence). We discussed that the 1D and 2D components dynamically exchange data at
runtime; the water level in the river is calculated and passed to the 2D, and the discharge is
extracted from/applied to the river network as a lateral outflow/inflow.

Part Two — River and Urban

In part two of this guide, we saw that a valid urban network is required when integrating
urban components and recalled how the model settings for the simulation associated to this
network could be adjusted in the ‘1D Urban Networks' section of the ‘Project’ panel. We saw it
is required to select ‘Dynamic Wave' as the routing model and to turn variable timesteps off.
We also paid attention to the timestep and start/end times of the urban simulation.

We recalled that a valid river network is required for integrating river networks and saw that a
link-reference must be defined to connect river and urban networks.

We used Flood Modeller’s built-in ‘1D Urban / 1D River’ linking definition tool to create this
link-reference file with just a few clicks of the mouse. This automatically created a link-
reference ready for use in our simulation.

Finally, we setup and ran our fully integrated simulation, visualising the results from this to
see the increased flow in the river. We used a timestep of 2.5 seconds, following the guidance
that 1D timesteps are equal to each other, and ensured the start and end times were
provided in absolute value format to ensure correlation with the 1D urban simulation.
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We considered the default link type of ‘Flow to river, stage to urban’ used for flows
discharging from a pipe network into a river. We discussed that the river and urban
components dynamically exchange data at runtime; the urban network discharge is applied
to/extracted from the river network as a lateral inflow/outflow, and the water level in the
river is calculated and passed to the connected urban node(s).

Part Three — Urban and 2D

In part three of this guide, we recalled that a valid urban network is required when integrating
urban components and it is required to select ‘Dynamic Wave' as the routing model and to
turn variable timesteps off.

We saw that when linking nodes other than outfall nodes, it is required to ‘Allow Ponding’ and
define a ponded area for each connected node.

We recalled that a DEM is required for 2D modelling and saw that a link-element must be
defined to connect urban networks and 2D components.

We used Flood Modeller’s built-in ‘1D Urban/2D’ linking tool to create the link-elements file.
This automatically created a link-element ready for use in our simulation.

Finally, we set up and ran our fully integrated simulation, animating the results from this to
see the water flow from the urban system across the active area. We used a 2D timestep of 5
seconds, following the guidance that the timestep (in seconds) is half the cell size (in metres)
as well as double the value of the 1D timestep (in seconds). We also ensured the start and
end times were provided in absolute value format to ensure correlation with the 1D urban
simulation.

We considered the default link type of ‘Q (flow) Link’ typically used for flood flows
discharging onto the floodplain. We discussed that the 1D and 2D components dynamically
exchange data at runtime; the discharge is applied to/extracted from the 2D domain, and the
resultant volume is calculated and passed back to the urban system.

What's next?
If you would like to find out more about integrated modelling, check out our YouTube
channel, user manual or get in touch with our support team.

g F M r www.floodmodeller.com
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https://youtube.com/playlist?list=PLTyinQYr8SPVatWqrcVLHuAiP2kZAozay
https://youtube.com/playlist?list=PLTyinQYr8SPVatWqrcVLHuAiP2kZAozay
https://help.floodmodeller.com/floodmodeller/#t=Home.htm
www.floodmodeller.com

	Introduction
	Part One: River and 2D
	Let’s get going!
	Step 1
	Step 2
	Step 3
	Step 4
	Step 5
	Step 6
	Step 7

	Part Two: River and Urban
	Let’s get going!
	Step 1
	Step 2
	Step 3
	Step 4
	Step 5
	Step 6
	Step 7

	Part Three: Urban and 2D
	Let’s get going!
	Step 1
	Step 2
	Step 3
	Step 4
	Step 5
	Step 6
	Step 7
	Summary
	Part One – River and 2D
	Part Two – River and Urban
	Part Three – Urban and 2D

	What’s next?




